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  Welcome to another issue of Full Circle!


  Full Circle is always expanding, and this month is no exception. We have Copil who is (rather bravely) stepping up as 'the new guy' to take your (easy) questions about Ubuntu and explain them in an manner that'll be perfect for a new user. So, if you've got an easy question, Ask The New Guy! For anything technical though you're still best to ask Gord (Q&A). Another new thing is Web Dev. Here Michael Youngblood will be explaining how to set up your own web development setting beginning this month with the first stage of installing LAMP.


  Elsewhere, the usual suspects are all here; Python, LibreOffice, GIMP, Inkscape and the final part of my Amateur Astronomy series. Although I'm explaining how to remote desktop a telescope that same theory will work for any time you need a remote desktop access, so give it a read.


  The Full Circle Podcast has now been successfully revived and the first episode with the new team released. It's a bit longer than normal, but in some parts you do get the added ambience of a diesel train engine in the background. You can grab the MP3/OGG from the FCM site, or click the download button on the right of this page to jump to the FCM site.


  And, just as a reminder, you can get the Full Circle PDF and EPUB from the FCM site, or you can grab the PDF via the Ubuntu Software Centre, or if you're on the move you can read FCM via Google Currents. The URL's for the Google Currents editions are on the relevant download page.


  All the best, and keep in touch!

  Ronnie

  ronnie@fullcirclemagazine.org


  # # # Linux - News # # #


  Linux Mint 13 KDE
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  The highlight of this edition is the latest KDE 4.8 desktop, which features the following improvements:


  


  
    	Kwin optimizations


    	Redesign of power management and integration with Activities


    	The first QtQuick-based Plasma widgets have entered the default installation of Plasma Desktop, with more to follow in future releases


    	New display engine in Dolphin


    	New Kate features and improvements


    	Functional and visual improvements in Gwenview

  


  For a complete tour of the new features in KDE 4.8, please visit http://www.kde.org/announcements/4.8.


  Source: linuxmint.com

  


  Linux Central To Higgs Boson Discovery


  An unnamed but apparently well-informed insider has argued that the [CERN] project's use of Linux was more than established convention.


  "I don't see any CERN-related things here, so I want to mention how Linux (specifically, Scientific Linux and Ubuntu) had a vital role in the discovery of the new boson at CERN," said the source on Reddit, sparking supporting comments from others involved in the field.


  "We use it every day in our analyses, together with hosts of open software, such as ROOT, and it plays a major role in the running of our networks of computers (in the grid etc.) used for the intensive work in our calculations," continued the source.


  Source: itworldcanada.com

  


  Commodore OS Uses Linux Mint


  Commodore USA who have already launched a retro styled Commodore 64 Extreme, which has been brought up to date and is now powered by an Intel Quad Core i7 Processor. Is developing a new operating system that will emulate the look and feel of the original.
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  The latest version of the new Commodore OS 1.0 Beta 9 is now available to download and is based on Linux Mint, and is capable of running apps which have been designed for Mint, Ubuntu, or other popular Linux distributions.


  Source: geeky-gadgets.com


  Command & Conquer #63 -

  General Tips


  by Lucas Westermann


  In the past two months I've been involved in group work at university. At first, we had to simply organize a group of 5 people (of which, ultimately, only 3 people did any work). We managed this quite easily with a single shared dropbox folder, and (for group write ups) a Google Doc file (shared with the “anyone with the link can edit” setting). However, as the project progressed we had to work first with a single other group, and then 5 other groups. Meaning at the end of the project, we were trying to manage 30 different people (and a smattering of operating systems, and people of varying degrees of technical proficiency). Generally, for any kind of group work where multiple people might edit the same file (likelihood of this increases as more people join the project) you should use Git. However, this can quickly become complex, and requires a certain level of technical proficiency to avoid unnecessary management by the repository owner. As such, I thought for this month's article I'd cover a few ideas I've had for managing data between groups. At the end of the article, I also run through a few useful tips I've stumbled upon for learning/practicing Japanese.


  The “Cloud”


  This includes anything like Dropbox, Ubuntu One, Google Drive, etc. This is by far the easiest method, and works like a charm for groups of 2 to 10 people, in my experience. Once you're past that upper limit, or you need to allow anyone to access the shared files, it's no longer a viable option. The reason for this is simple – it's designed to be user-friendly, and forgoes some of the more advanced management features (robust version control, merging options, public access with merge-back capabilities, and so on).


  For anyone concerned about security, it's possible to create a Truecrypt volume and store it in the cloud (in Dropbox at least, I haven't tested this with any of the others). Offering the passcode for the volume to the other group members should be done in person or via phone for maximum security.


  Revision Control


  This is by far the most versatile system I've used to date. You can use something like Github to create and manage your repository, and it is publicly available for forking (creating a copy of it) for other people to work on. Once the changes have been made, they will be merged back “upstream” after which the repository owner will need to go through the commits/merges and accept them into the final version. Each merge is saved as a version, allowing you to easily move back to an older revision if necessary. I used this to great success last year when I wrote a LaTeX-based script for a mathematics lecture at university, allowing anyone in the class to make changes or corrections to the files. By the end of the semester our script was often more thorough than that of the professor himself.


  Security-wise I'd list this as one of the “best” options, simply due to the fact that any change has to be approved by someone who's in charge. It's also possible to create a custom server on a personal network for use with svn or git, for completely in-house solutions.


  Single File Group Work


  By this I'm referring to collaboration on a single file, which needs to be (or simply will be) edited by multiple people at once in real-time. For this, I've not found anything that does it as easily as Google Docs. If, however, anyone is against Google for such things and has access to a server, you could create an implementation of Apache Wave or Walkaround, which are based off of Google Wave. They should offer a similar real-time collaboration option, though a more limited range of document formats.


  Security is on-par with Dropbox, in my opinion. This is especially true if you require every collaborator to have an account, as opposed to the “anyone with the link can edit” option I mentioned above.


  If anyone has used a program or system that they think deserves to be mentioned, please let me know via email (address is below), and I'll be sure to mention it at the beginning of my next article. Please mention anything like cost, availability, etc.


  Language-learning Programs


  For anyone who owns an android phone/tablet, I highly recommend Human Japanese, which has been one of the best explained introductions to Japanese I've read. It doesn't, however, use any Kanji, relying instead on Hiragana/Katakana. The benefit of this is that you can build up vocabulary faster (since you don't need to tell Kanji apart or learn them), and also that, if you're aiming for a solely verbal communication level, you don't learn anything unnecessary. It also offers great tips for tourists when visiting Japan. At the time of writing, it's available in the Google Play store for 6,99€. Also worth mentioning is that there is a Mac OS X version of the same application available in the App Store, for anyone who owns a Mac. Also, the iOS App Store also offers Human Japanese, albeit for 7,99€.


  Flashcard programs of any sort are extremely useful for remembering vocabulary. I can't name any specific programs, since I haven't used any recently. Trivialibre might also be a valid option for doing this (introduced in Command & Conquer, FCM#58).


  Book-wise, I've read and used Japanese in Mangaland 1 & 2 (and the corresponding workbooks) by Marc Bernabe. The books are well-written, and the illustrations help underscore the main points of every chapter. The illustrations also help your ability to read hand-written (or at least, the style of writing used in manga) Japanese, which may be useful in the future. The workbooks, as well, help drill the vocabulary and grammar into your head. The stories used in the books are also well-drawn and written, for anyone who is interested in that sort of stuff.


  Listening to as much Japanese as possible helps to improve your own pronunciation. This can be either music, audiobooks, or television shows. If you decide on the television/movie route, definitely watch it with subtitles, as you can also start linking meanings to phrases. Finding Japanese books you find interesting (manga, Shogi books, novels, etc.) will also help you improve, once you're capable of reading basic sentences. If the book truly interests you, it will help balance out the tediousness of having to read while having a dictionary close at hand. Also, for dictionaries I highly recommend electronic versions (gwaei, for example). The reason for this is simple – they offer stroke-based input/searches, meaning you don't need to be able to recognize the Kanji, or even read it, if you can figure out the stroke order. Paper dictionariestend to require both these things.


  Last, but not least, regardless of what language you're learning, it's a wasted effort unless you use it! To this end, I present to you Lang-8: http://lang-8.com/. This is a website where each user gets a journal, in which they can write entries, in both the language you're learning and your intended meaning in your native tongue. The journal is then corrected by other users. Each correction is split by sentence, and can be commented on by the person correcting it. This means that you'll be getting the opinion of a native speaker on how to speak his or her language in the most natural way. This is a wonderful option for anyone who doesn't have friends who speak the language they're learning, don't want to bother their friends with constant questions, or who don't have the option to go to that country and “jump into the deep end”, as it were.


  As always, I hope you found this article helpful. I do realize that the two topics I covered in the article are not at all connected. However, this means that there should be something in here for everyone. If you have any questions, comments, or suggestions, feel free to email me at lswest34@gmail.com. If you do email me, please put FCM or C&C in the subject line, to make certain I don't overlook it.


  Beginning Programming using Python - Part 35

  Kivy


  by G.D. Walters


  This time, we are going to take a short detour from our exploration of Android programming, and look at a new framework for GUI programming called Kivy. You’ll want to head over to http://kivy.organd download and install the package – before getting too far into this month’s installment. The Ubuntu installation instructions can be found at http://kivy.org/

  docs/installation/installation-ubuntu.html.


  First off, Kivy is an open source library that makes use of multi-touch displays. If that isn’t cool enough, it’s also cross-platform, which means that it will run on Linux, Windows, Mac OSX, IOS AND (ta-da) Android. Now you can see why we are talking about this. But remember, for the most part, anything you code using Kivy, can run on any of the above platforms without recoding.


  Before we go too far, let me make a couple of statements. Kivy is VERY powerful. Kivy gives you a new set of tools to make your GUI programming. All that having been said, Kivy is also fairly complicated to deal with. You are limited to the widgets that they have provided. In addition, there is no GUI designer for Kivy, so you have to do a GREAT deal of pre-planning before you try to do anything complicated. Also remember, Kivy is continually under development so things can change quickly. So far, I haven’t found any of my test code that has broken by a new version of Kivy, but that’s always a possibility.


  Rather than jump in and create our own code this month, we’ll look at some of the examples that come with Kivy, and, next month, we’ll “roll our own”.


  Once you’ve unpacked Kivy into its own folder, use a terminal and change to that folder. Mine is in /home/greg/Kivy-1.3.0. Now change to the examples folder, then to the widgets folder. Let’s look at the accordion_1.py example.


  It’s very simple, but shows a really neat widget. Here’s their code...


  
    from kivy.uix.accordion import Accordion, AccordionItem

    from kivy.uix.label import Label

    from kivy.app import App

    

    class AccordionApp(App):

     def build(self):def build(self):

      root = Accordion()

      for x in xrange(5):

       item = AccordionItem(title='Title %d' % x)

       item.add_widget(Label(text='Very big content\n' * 10))

       root.add_widget(item)

      return root

    

    if __name__ == '__main__':

     AccordionApp().run()AccordionApp().run()
  


  As you can see, the first three lines are import statements. Any widget you use must be imported, and you must always import App from kivy.app.


  The next eight lines are the main application class. The class is defined, then a routine called build is created. You will almost always have a build routine somewhere in your Kivy programs. Next we set a root object from the Accordion widget. Next we create five AccordionItems and set their title. We then add ten labels with the text “Very big content”. We then add each label to the root widget (the Accordion) and then finally we return the root object. This, in essence, displays the root object in the window that Kivy creates for us. Finally we have the “if __name__” statement and then run the application.


  Go ahead and run it to see what it does.


  You will see that in a moment or two, a window opens up with five vertical bars in it. Clicking on a bar causes it to open up revealing the ten labels. Of course, each bar has the same text in the ten labels, but you can figure out how to fix that.


  The Accordion widget can be used for any number of things, but the thing that has always jumped to my mind is for a configuration screen... each bar being a different configuration set.


  Next we’ll look at the textalign.py example. It’s not as “sexy” as the last one, but it’s a good example that gives you some important information for later on.


  Before we look at the code, run the program.


  What you should see is a label at the top of the window, a set of nine red boxes with text in a 3x3 grid, and four buttons along the bottom of the window. As you click (tap) each of the buttons, the alignment of the text within the red boxes will change. The main reason you would want to pay attention to this example is how to use and control some of the important widgets as well as how to change the alignment in your widgets, which is not completely intuitive.


  Here’s their code for this one. I’ll break it into pieces. First the import code...


  
    from kivy.app import App

    from kivy.uix.label import Label

    from kivy.uix.gridlayout import GridLayout

    from kivy.uix.floatlayout import FloatLayout

    from kivy.properties import ObjectProperty

  


  Below is something special. They created a class with no code in it. I’ll discuss that in a few minutes.


  
    class BoundedLabel(Label):

     pass

  


  Next a class called “Selector” is created.


  
    class Selector(FloatLayout):

     app = ObjectProperty(None)

  


  Now the Application class is created.


  
    class TextAlignApp(App):

     def select(self, case):

      grid = GridLayout(rows=3, cols=3, spacing=10, size_hint=(None, None),

       pos_hint={'center_x': .5, 'center_y': .5})
  


  Here the routine select is created. A GridLayout widget is created (called grid) which has 3 rows and 3 columns. This grid is going to hold the nine red boxes.


  
    for valign in ('bottom', 'middle', 'top'):

     for halign in ('left', 'center', 'right'):
  


  Here we have two loops, one inner and one outer.


  
    label = BoundedLabel(text='V: %s\nH: %s' % (valign, halign),

     size_hint=(None, None),

     halign=halign, valign=valign)

  


  In the code above, an instance of the BoundedLabel widget is created, once for each of the nine red boxes. You might want to stop here and say “But wait! There isn’t a BoundedLabel widget. It just has a pass statement in it.” Well, yes, and no. We are creating an instance of a custom widget. As I said a little bit above, we’ll talk more about that in a minute.


  In the code block below, we examine the variable ‘case’ which is passed into the select routine.


  
    if case == 0:

     label.text_size = (None, None)

    elif case == 1:     label.text_size = (label.width, None)

    elif case == 2:      label.text_size = (None, label.height)

    else:

     label.text_size = label.size

      grid.add_widget(label)

  


  Here, the grid is removed, to clear the screen.


  
    if self.grid:

     self.root.remove_widget(self.grid)

  


  The bind method here sets the size, and the grid is added to the root object.


  
    grid.bind(minimum_size=grid.setter('size'))

    self.grid = grid

    self.root.add_widget(grid)

  


  Remember in the last example I said that you will almost always use a build routine. Here is the one for this example. The root object is created with a FloatLayout widget. Next we call the Selector class to create a Selector object, then it’s added to the root object, and we initialize the display by calling self.select(0).


  
    def build(self):

     self.root = FloatLayout()

     self.selector = Selector(app=self)

     self.root.add_widget(self.selector)

     self.grid = None

     self.select(0)

    return self.root

  


  Finally the application is allowed to run.


  
    TextAlignApp().run()
  


  Now, before we can go any further, we need to clear up a few things. First, if you look in the folder that holds the .py file, you’ll notice another file called textalign.kv. This is a special file that Kivy uses to allow you to create your own widgets and rules. When your Kivy application starts, it looks in the same directory for the .kv helper file. If it is there, then it loads it first. Here’s the code in the .kv file.


  This first line tells Kivy what minimum version of Kivy that must be used to run this app.


  
    #:kivy 1.0
  


  Here the BoundedLabel widget is created. Each of the red boxes in the application is a BoundedLabel.


  
    <BoundedLabel>:

     canvas.before:

      Color:

      rgb: 1, 0, 0

       Rectangle:

       pos: self.pos

       size: self.size

  


  Color sets the background color of the box to red (rgb: 1,0,0). The Rectangle widget creates a (you guessed it) rectangle. When we call the BoundedLabel widget in the actual application code, we are passing a label as the parent. The size and position (here in the .kv file) are set to whatever the size and position of the label are.


  Here the Selector widget is created. This is the four buttons that appear at the bottom of the window as well as the label across the top of the window.


  
    <Selector>:

     Label:

      pos_hint: {'top': 1}

      size_hint_y: None

      height: 50

      font_size: 16

      text: 'Demonstration of text valign and halign'

     BoxLayout:

      size_hint_y: None

      height: 50

      ToggleButton:

       halign: 'center'

       group: 'case'

       text: 'label.text_size =\n(None, None)'

       on_release: root.app.select(0)

       state: 'down'

      ToggleButton:

       halign: 'center'

       group: 'case'

       text: 'label.text_size =\n(label.width, None)'

       on_release: root.app.select(1)

      ToggleButton:

       halign: 'center'

       group: 'case'

       text: 'label.text_size =\n(None, label.height)'

       on_release: root.app.select(2)

      ToggleButton:

       halign: 'center'

       group: 'case'

       text: 'label.text_size =\n(label.width, label.height)'

       on_release: root.app.select(3)

  


  Notice that the label that makes up the title at the top of the window has a position (pos_hint) as top, has a height of 50 pixels and a font size of 16. Each of the buttons has an alignment for the text of center. The on_release statement is a bind-like statement so that, when the button is released, it calls (in this case) root.app.select with a case value.


  Hopefully, this is beginning to make sense now. You can see why Kivy is so powerful.


  Let’s talk for a moment about two widgets that I have passed over in the discussion of the application code, The GridLayout and the FloatLayout.


  The GridLayout is a parent widget that uses a row and column description to allow widgets to be placed in each cell. In this case, it is a 3x3 grid (like a Tic-Tac-Toe (or Naughts and Crosses) board).


  
    __|__|__

    __|__|__
  | | 

  


  When you want to place a widget into a GridLayout, you use the add_widget method. Here lies a problem. You can’t specify which control goes into which grid cell other than the order in which you add them. In addition, each widget is added from left to right, top to bottom. You can’t have an empty cell. Of course, you can cheat. I’ll leave that up to you to figure out.


  The FloatLayout widget seems to be just a parent container for other child widgets.


  I’ve glossed over a few points for now. My intent this time was simply to get you somewhat excited about the possibilities that Kivy has to offer. In the next couple of articles, we’ll continue to explore what Kivy has for us, how to use various widgets, and how to create an APK to publish our applications to Android.


  Until then, explore more of the examples in Kivy, and be sure to go to the documentation page for Kivy at http://kivy.org/docs/.

  


  
    BIO:

    Greg Walters is owner of RainyDay Solutions, LLC, a consulting company in Aurora, Colorado, and has been programming since 1972. He enjoys cooking, hiking, music, and spending time with his family. His website is www.thedesignatedgeek.net.
  


  LibreOffice Part 16: Impress Master Pages and Styles


  A great presentation begins with a pleasing and well thought out slide design. You also need consistency between your slides, elements that fit them together. In LibreOffice, you can use the Master Pages to create the base design for your presentation. Master Pages become the framework for the entire presentation, binding the elements of our presentation together. Much of this is accomplished through styles, and Master Pages are the main style. You can think of Master Pages being equivalent to Page Styles in Writer.


  Editing Master Pages


  To edit master pages, you must switch to the Master View. Start Master View through View > Masters > Slide Master. Alternatively, you can right-click the master page you want to edit in the Master Page section of the Tasks pane, and select Edit Master.
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  When you enter Master View, the master toolbar appears. The master toolbar gives you options specific to editing master pages. Use add to add a new master page. Delete allows you to delete the selected master page. Delete is grayed out when you have only one master page, because you must have at least one. Rename lets you rename the currently selected master page, and Close Master View exits master page editing.


  You have five predefined editable areas in a master page:
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  Title Area– The title area contains the title of the slide. Think of it as the subject of the slide.


  Object Area– The object area contains the data of the slide, whether it is text, an image, a chart, or a table. As you will learn, the data of the slide is not confined to the object area. You can add elements outside the object area, but it's a good idea to keep data generally in this area for consistency in your presentation.


  Date, Footer, and Slide Number Area– By default, these areas do not show up on the actual slide. To change, go to View > Header and Footer, and you can change whether or not these objects will appear on the slides.


  Modifying the Master Page


  We will start with the default style for your master page. First, let's change the background. Format > Page. On the background tab, use the dropdown box and select gradient. In the gradient list, select Radial red/yellow. Click OK. This gives you a bright, sunny background to work on.
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  NOTE: You can download the icon graphic used in this tutorial at http://eeperry.co.cc/resources/modules.png.


  Next, we will add a graphic to your master page. The graphic will show up on all slides that use this master page. I created a ribbon graphic containing the icons for all the LibreOffice applications. We want it to sit just below the object area. Insert > Picture > From file. Select your picture and Open. Move the image to the position you want it, just below the object area. You want the image centered at the bottom. Rick-click the image and select Alignment > Centered. You also want the image to appear behind any objects which might go over it. Right-click the image again, and select Arrange > Send to back.


  Now, let's add a line under the title. Select the line tool from the drawing toolbar at the bottom of the window, and draw a line under the title area. You can change the line style using the line toolbar. Change the style of the line, the thickness, color, and the start and end arrow styles.
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  Finally, let's edit the date, footer, and slide number areas. While in Master View, you can change the size and placement of these objects, but actually filling them with content can be done at any time. View > Header and Footer. On the slide tab, there is a checkbox for each of the three areas: date, footer, and slide number.


  Under date and time, you can choose a fixed date or a variable date. You can use fixed date when you have a presentation that is presented one time, or you want the date to appear in a non-standard way. Place your date text in the textbox beside the variable selection. What you place in the textbox is what will show in the date textbox on the slide. Use variable date when a presentation date is unknown, or you will give the presentation more than once. Variable will place the current date in the date textbox. With variable, you need to select a format in the dropdown. You can also change the language.


  For the footer area, you type the text you want in the footer area in the textbox. Whatever you type in the textbox appears in the footer area.


  There's not much to the slide number. You either check it to show or not show. When checked, the slide number will show up in the slide number area.


  NOTE: The date, footer, and slide number areas are disabled on the first slide, the title page.


  Click the Apply to All button to apply the settings to all the slides except the title page. Click the Apply button to apply it to only the current slide.


  Impress Styles


  Just like in Writer and Calc, Impress can use styles to keep everything uniform. Styles are also a time saver. However, styles are a little different in Impress. Impress only has two different style types, Presentation and Graphic.


  An easy way to think about presentation styles is as the styles related to the master pages. You have styles for backgrounds, background objects, outline text, notes, titles, and subtitles. You can modify these styles any way you want. However, you cannot create new presentation styles.


  Graphics styles are styles for objects and text not directly related to the master pages. You can modify these styles in any way you want, and you can create new ones.


  Editing of styles is done from the Styles and Formatting dialog. You can open the Styles and Formatting dialog by clicking on the button in the line and filling toolbar, pressing the F11 key on the keyboard, or by going to Format > Styles and Formatting.


  Let's do a couple of modifications to the presentation styles to show how they work. First, enter master view mode, View > Master > Slide Master, and open the Styles and Formatting dialog, Format > Styles and Formatting. Right-click Title in the dialog and select Modify. On the font tab, select a suitable serif or slab font. Maybe make it bold. Switch to the area tab and change the fill to gradient. Select the first gradient in the list (black to white). On the transparency tab, switch the mode to transparency and the percentage to 50%. Click OK, and you will see the font for the title has changed and it has a semitransparent gradient background.


  Now, select Outline 1 in the Styles and formatting dialog. Right-click and modify. All we want to do here is change the font. Click OK. Switch to Master View and you will notice that the font is changed for all the outline levels. This is because each of the outline levels links to the previous one. You can't change the linking, but you can change each of the levels to be different. This cascade effect can be useful, especially with the font in helping to create uniformity.
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  In this how-to, we learned about creating and modifying master pages in Impress. Master pages are key to helping create consistency in your presentation. We also looked at presentation styles and how they help create the style for your slides. I encourage you to play around with the master page settings and presentation styles. The presentation styles have 14 different tabs, making them very flexible. You can create a very professional and visually appealing presentation with these tools.


  Next time, we will begin work with individual slides.


  HowTo - Amateur Astronomy Part 2


  by Ronnie Tucker


  Astronomy can be a cold hobby. Sitting out in a field or garden wearing two jackets and gloves, while trying to read a sky map and trying to stop your telescope from becoming airborne can be something of a hazard. If you’re DIY-minded, you could build yourself a small observatory with a sliding roof and a warm room. Or, if you’re a sissy like me, leave your telescope out in the cold and watch things from the comfort of your own home.


  Webcam


  The first thing you’ll need is a webcam. This will be your eyes, so it needs to be securely attached to your telescope or eyepiece. Some folks prefer to remove the eyepiece and put the webcam where the eyepiece should go. Some (ie: me) prefer to attach the webcam to the eyepiece to get a closer view of things. Attaching the webcam to the eyepiece is completely subjective. Some folks will buy a special attachment. Some (ie: me) will hack something up using cardboard and masking tape (don’t use gaffer’s tape, it will inevitably spoil your telescope). Whatever you do, the webcam must be stable – especially if you intend to use it for astrophotography. The webcam does not need to be big, fancy and HD.


  Networking


  I use my old laptop as my external brain. It’s linked to my desktop PC via wireless network. You could, if it came to it, use a wired network. Either way, you need to have your laptop connected to the Internet somehow. The connection we’ll make also comes in handy for wirelessly transferring any photos or videos you may take while (not quite) out in the field.


  Out In The Cold


  So, you have your webcam on your scope. Your webcam application is showing you what your webcam can see, but you’re still out in the cold. Now what?


  Remote Desktop


  First, you want to head over to: http://www.teamviewer.com, and download TeamViewer(which is free for non-commercial purposes). TeamViewerneeds to be installed on both the laptop and desktop machines, and acts as both a server (transmitting) and a receiver (displaying). So, you obviously want to register with the TeamViewer website. Then, load TeamViewer on the laptop and desktop machines. First thing you want to do is go to Extras > Options, and set a password for each machine. When you first load TeamViewer, you’ll see a unique ID and password; that will change each time you load.
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  TIP: You should probably add TeamViewer to your list of applications that load on startup. If TeamViewer isn’t loaded you can’t connect to that machine, and there are times when you may have to send a reboot command to the machine you're logged into.


  Not very helpful since, if you’re at the desktop machine, you can’t see the ID of the laptop to log in with! But, help is at hand. We’ll register the machines with TeamViewer. Click the ‘Computers & Contacts’ button at the bottom right of TeamViewer, you’ll see a window pop-up.
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  Initially, your pop-up window won’t list anything in it, but we’ll soon fix that. Click the icon second from the right, looks like a computer monitor with a ‘+’ symbol over it. This will let you register one, or more, computers with TeamViewer letting you login without having to remember a URL/IP.
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  So, with the laptop and desktop machine registered with TeamViewer they’ll show up anytime we login to TeamViewer, and appear in the pop-up window. Simply double clicking one of the entries listed will connect to that machine.
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  So now I’m controlling my laptop from the comfort of my desktop. I can control it as if I was sitting in front of it. Configure settings, load/exit applications, anything. Clicking the ‘X’ in the middle left of the desktop will exit the session. You’ll also notice (in that menu that’s overlaying the laptop desktop) a ‘File Transfer’ button. This, as you can imagine, allows the transfer of files to/from the connected machines.
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  This saves you from copying images/videos to/from USB sticks. The window that appears acts like an FTP application where you click a file(s) and click which way you’d like the file(s) to go in. So, in the image shown, I’ve clicked a video on the laptop, and will click the blue left facing arrow (marked ‘Receive’) to transfer the file to my desktop machine.
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  As well as having a webcam application running, you can, of course, have mount controls loaded and be controlling your mount remotely too while watching your camera. If your laptop has a webcam in it, you can point the webcam at your mount and have that on screen too!
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  TIP: If you leave your laptop/desktop set up, and you’re at work, you can still log into any of your machines via the TeamViewer website (laptop login shown above).


  Although it may seem pointless to have a webcam pointing at the same patch of sky for any length of time, this setup does come in handy for astrophotography as you can leave the laptop recording video for several minutes (or hours), and keep an eye on it to make sure your camera/mount hasn’t moved or to stop/start a recording – a recording which could be put through one of the image stacking applications I mentioned last month.


  Retro Photo in GIMP


  by Thomas Standiford


  In this GIMP how-to, we're going to do some basic curves adjustments to make this photo have a cool stylized retro-type look.


  Start with this:
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  End with this


  [image: ]


  Get the Retro Colors


  Most of the effect for this photo is simply from adjusting the curves of each channel (the red, green, blue, and alpha channels) like so:
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  Note: To change which channel to adjust, select the channel from the channel drop-down. You can switch back and forth between channels. All of these curves adjustments should be done in ONE COMMAND, not a series of four commands.


  After making the adjustment, your photo should look something like this:
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  This looks pretty cool, but we need to tone the contrast down a bit.


  Next, do another curves adjustment like so:
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  My photo looks like this:
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  Not bad, now if only those bubbles didn't disappear in the process.


  Enhance the Bubbles


  The bubbles seem to have disappeared in this photo. We're going to use a combination of selections, and soft brushes to put some pop back into them.


  Create a new layer, name it "bubbles".


  Now we will select the bubbles. Using the path tool, trace around the outer edge of each bubble.


  Once all of the bubbles have been outlined, right-click on the path in the path menu (located in the same window as the layers), and click "path to selection."


  Set your foreground and background to a lime green and hot pink.


  Using a fairly large and soft brush, carefully brush in a few spaces of pink and green in each bubble, like so:
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  Now that we have added the color to the proper areas of the bubbles, let's change some layer styles and adjust the opacity to make the bubbles look realistic.


  Set the layer mode to Overlay.


  Duplicate the layer. Name the duplicated layer "bubblebrighten".


  Set the duplicated layer mode to addition.


  Adjust the opacity of both the "bubble" and "bubblebrighten" layer until you end up with something you're happy with. My opacity settings are set to 23 and 40 respectively, and they look like this:
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  Now that our bubbles are a little more visible, let's dramatize the photo a bit.


  Final Touches


  Create a new layer, name it "dramatize", set the layer mode to Overlay, and fill the layer with black.


  Add a layer mask to the dramatize layer.


  Using the blend tool, set the gradient mode to radial, and use a gradient that goes from black to white. Create a gradient that goes from the center of the photo outward. Adjust the opacity of the layer to something you're happy with. Here is what I ended up with:
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    Next month we’ll begin a series of video editing articles using Kdenlive.
  


  Drawing with Inkscape – Part 3


  By Mark Crutch


  Here's a riddle for you: when is a circle not a circle? More specifically, which of these two circles is a circle, and which one isn't?
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  They may look the same, but they're not. If you double-click on each of them to make their edit handles visible, you can start to see a difference.


  The one on the left is the true circle, created by holding down CTRL while drawing an ellipse. The other is a square, created by holding CTRL while drawing a rectangle, which has had its corners rounded using the small circle handles.
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  Often it's quite obvious what type of object you're working with in Inkscape, but as your drawings become more complex, and as you begin to use more and more tools, it's easy to lose track. Some features only work with particular types of objects, so it's handy to be able to tell at a glance exactly what you've got selected. Inkscape reveals that information – and a whole lot more – in the status bar at the bottom of the window. Here's the relevant part of the status bar when each of these “circles” is selected with the Select tool:
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  From that information it's quite obvious that the two circles are different. But that image has been edited a little; the text actually reads “Ellipse in layer Layer 1. Click selection to toggle scale/rotation handles.” The status line is telling you that clicking your selected object will toggle between the scale handles and the rotation & skew handles.


  In fact much of what has been verbosely described in the previous two articles can be found written far more succinctly in Inkscape's status line. With the Circle tool selected you're told to “Drag to create an ellipse. Drag controls to make an arc or segment. Click to select.” In this case “drag controls” is Inkscape's terminology for moving the small square and circle handles. A similar line when the Rectangle tool is selected suggests you can “Drag controls to round corners and resize.”


  Hovering the mouse pointer over the various handles also provides valuable information in the status line, including this gem when you use the circle handles on an ellipse: “...drag inside the ellipse for arc, outside for segment.” So if you were wondering about Inkscape's seemingly random switching between segments and arcs, it turns out not to be random after all. Keep the pointer inside the boundary of the ellipse if you want to create an arc, and outside if you want to create a segment – although you can always switch using the toolbar buttons if you end up with the wrong type of object.


  As well as these handy tips, the status bar also houses a few other things that you should become familiar with if you want to make the most of your time with Inkscape. At the far left are the fill and stroke swatches that were introduced back in the first part of this series. In theory you can click and drag on them in order to change their colors, but I've always found that to be an imprecise and awkward approach. Next month we'll look at the Fill and Stroke dialog which is a much better way to pick colors that aren't present in your color palette.
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  The stroke thickness offers an equally useless facility to click and drag in order to change its value. For most quick changes a right-click on the number to bring up the context menu is a much better option.


  The spin-box labelled with a cryptic “O:” lets you set the opacity of your selected objects. It's shown as a percentage, so 100 is the norm for a completely opaque color whilst 0 will render your objects completely transparent. Inkscape has lots of ways to make your objects transparent, which can be a real problem for new users. You can set a value in this box by typing directly, by using the up and down buttons at the side, or by right-clicking to bring up a rather coarse five-step context menu. I usually use the context menu, at least as a starting point, and, if nothing else, it provides a fast way to get back to 100% opacity when you're in danger of losing your transparent objects.


  The eye and lock icons, and the pop-up menu that follows them, are all related to layers. I'll be covering layers in a later article, but there are three things worth knowing about them at this stage:


  
    	If you're familiar with layers in GIMP or another graphics program, layers in Inkscape work in a similar way.


    	Clicking the eye button is another of the many ways to make your objects disappear from the screen – in this case by hiding the layer they're drawn on. The icon changes to a closed eye in this case and you can simply click it again to display the layer once more.


    	If the lock icon looks like a closed padlock, then your layer is locked and you won't be able to draw anything new onto it. Click the icon again to unlock it.
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  To the right of the status text is a pair of fields which show the X and Y coordinates of your mouse pointer, relative to the bottom-left corner of the page boundary. You can't modify these in any way, other than by moving your mouse, as they're just there for information. Be warned, however, that Inkscape's choice of the bottom-left of the page as the origin point is different to the SVG specification's use of the top-left corner – it's not a distinction that will affect most people, but it does mean that if you're a programmer type who wants to edit the SVG file directly, these values are almost useless to you.


  The last Inkscape-specific widget in the status bar is a zoom spin-box which shows you the current zoom level, lets you set a specific value by typing or using the up and down buttons or pick from a few standards via a context menu. There are so many other zoom tools, including the CTRL plus scroll wheel and the +/- keys which I've described previously, that I doubt you'll ever use this widget. Finally there's a handle to resize the window.


  Let's finish this month by introducing another drawing tool to your arsenal: the Stars and Polygons tool. It's got an icon in the tool box[image: ]and can also be activated using the asterisk key (easy to remember because it looks a little like a star) or SHIFT-F9. Dragging out a shape on the canvas will produce either a convex polygon or a concave, star-like, polygon. You can switch between the two modes using the first two buttons on the tool control bar.
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  Depending on which mode you're using, you'll see either one or two small diamond-shaped handles. These let you adjust the size, rotation and, for concave polygons, the spoke ratio. By holding various modifier keys as you move them, you can also adjust several other parameters (have a look at the status bar for the details) – although I usually prefer to change them using the spin-boxes in the tool control bar.
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  The only parameter that can't be changed via the diamond handles is the number of corners on your polygon, but the other advantage to using the spin-boxes is that, like the spin-boxes on the status bar, they each have a context menu that you can access with a right-click. These context menus are tailored to each spin-box separately, with descriptive titles to provide you with a little insight into the effect they'll have.


  The best way to get a feel for the Star tool is simply to play with it. Try different combinations of values in the spin-boxes. If your objects start to get a little out of control just click the button at the right of the tool control bar – the one that looks like a small broom – in order to 'clean up' the parameters back to sensible defaults. To give you some idea of what you can achieve simply by tweaking the parameters for the Star tool, this image contains six identical polygons which differ only in the settings in their spin-boxes:


  [image: ]


  To go back to the question that started this article, you now have a third way to create a 'circle' – draw a convex polygon with a large number of corners. It's not a particularly good way to draw a circle, and it's certainly not efficient, but it does reinforce the fact that objects in Inkscape aren't always what they seem. Keep an eye on the status text.


  Why not use this new tool to add some stars to the background of your snowman image from the previous articles. The same tool will also let you replace those circles that we used for the eyes and mouth with slightly randomised convex polygons – far more authentic as lumps of coal.
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    Mark has been using Linux since 1994 and uses Inkscape to create two webcomics, 'The Greys' and 'Monsters, Inked' which can both be found athttp://www.peppertop.com/
  


  Web Dev Corner

  Installing the LAMP Stack - Part 1


  by Michael R. Youngblood


  The “LAMP Stack” is traditionally Linux, Apache, MySQL, and PHP. This is the most necessary portion of any server to any web developer, whether you’re specializing in PHP or even mobile development. You just simply cannot develop a web site or web app without a web server. Of course, there are other flavors of web servers that use other technology, but this is the standard and will be our starting point.


  For the sake of this new column, I have set up a new Virtual Server to go through with you as we go. My server is running Ubuntu Server 64bit 10.10. This month we will get Apache2 installed and configured. I am also assuming you know how to edit files using terminal and vi, this is what we will be using the whole time. Let’s jump right into that.


  If you are not root (and you shouldn’t be for security reasons), you need to run apt-get commands using sudo, and all my examples will assume you are logged in as a user. Run the following code to install apache2:


  
    sudo apt-get install apache2
  


  By default, now it works. It is listening to all IP’s available to it, anything coming to that box on port 80 will now go to the default web site. Pretty easy stuff so far. All of your files will be located in the following directory:


  
    /srv/www/
  


  I have a feeling that we will want a few different sites to play around with, so I am going to show you how I set things up. Instead of using the default path and apache config setup, we will use virtual hosts. From here on out, I will use example.com. You will want to replace that with your own domain name.


  Make a new virtual host config file into /etc/apache2/sites-available/ with the following command:


  
    sudo vi /etc/apache2/sites-available/example.com
  


  Now let’s get some config in there. Go ahead and use this simple sample configuration.


  
    <VirtualHost *:80>

      ServerAdmin webmaster@example.com

      ServerName example.com

      ServerAlias www.example.com

      DocumentRoot /srv/www/example.com/public_html/

      ErrorLog /srv/www/example.com/logs/error.log

      CustomLog /srv/www/example.com/logs/access.log combined

    </VirtualHost>
  


  Remember to change example.com to your doman name. This stuff is kind of boring so I am just going to run through it really quick. ServerAdmin is for an email address of who or a group that maintains the site. ServerName should be the base name of the site. Please note, if your site is a sub-domain then you will need to put x.example.com in the ServerName. The ServerAlias is the full web address that will be going to your site. DocumentRoot is where all of your public files will be held. I took the liberty of giving you error log reporting to make finding and fixing problems easier in the future. Before any of that will work, we need to create those directories for real. That, of course, is as easy as making directories:


  
    mkdir -p /srv/www/example.com/public_html

    mkdir /srv/www/example.com/logs
  


  Sweet, now we got some stuff going on. Now let’s activate that bad boy:


  
    sudo a2ensite example.com

    sudo /etc/init.d/apache2 reload
  


  The a2ensite is actually a really cool command. It says apache2, enable site x. There is also a2dissite for disabling. This will use the site config files we made in the sites-available directory and copy them into the sites-enabled directory. Although we could do it ourselves, it is just good practice to let apache handle its own files when it is able. The other statement there is telling apache to reload its configuration files.


  Well, that is it for this month. Next time we will be installing PHP and MySQL to complete the LAMP stack.

  


  
    BIO: Michael Youngbloodhas been in the industry of web design and development for 13 years. He has been working for a world wide wireless tech corp for six years and is working on his bachelor’s of science in mobile development.
  


  Guidelines


  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives - Kubuntu, Xubuntu, Lubuntu, etc.


  Write your article in whichever software you choose - I would recommend LibreOffice. But, PLEASE SPELL AND GRAMMAR-CHECK IT!


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression.


  For a more detailed list of the style rules and common pitfalls, please refer to:https://wiki.ubuntu.com/UbuntuMagazine/Style- in short: US spelling, no l33t speak, and no smilies.


  When you are ready to submit your article, please email it to:

  articles@fullcirclemagazine.org


  If you can't write articles, but hang out in Ubuntu Forums, send us interesting forum threads that we could print.


  Non-English Writers


  If your native language is not English, don't worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we'll help you with your English!


  FOR REVIEWS:

  Games/Applications


  When reviewing games/applications, please state clearly:


  
    	title of the game


    	who makes the game


    	is it free, or a paid download?


    	where to get it from (give download/homepage URL)


    	is it Linux native, or did you use Wine?


    	your marks out of five


    	a summary - with positive and negative points

  


  Hardware


  When reviewing hardware, please state clearly:


  
    	make and model of the hardware


    	what category would you put this hardware into?


    	any glitches that you had while using the hardware?


    	easy to get the hardware working in Linux?


    	did you have to use Windows drivers?


    	marks out of five


    	a summary - with positive and negative points

  


  You don't need to be an expert to write an article - write about the games, applications and hardware that you use every day.


  NEW!

  Ask the New Guy


  by Copil Yáňez


  My high school had a computer club that competed in the annual Computer Olympiad. It was a lot like the Olympics – only without the medals, interviews, lucrative endorsement deals, doping allegations or fans. Actually, it wasn’t anything like the Olympics. Except for the insane amount of sweating.


  On the designated day, teams of brainy teenagers huddled in a hot cafeteria and worked against a time limit to carry out a given programming task. Completed programs were then judged on relevance, brevity and elegance (no, dressing up your TRS-80 in top hat and tails will NOT get you extra points – I tried).


  Our team usually did well. Not because we were smarter than the other teams but because we had something no other team had.


  Me.


  That’s right, I was clearly the most important bull in the nerd herd. Why?


  I was the typist.


  Someone had to enter the string of geek-speak being spouted by my teammates and I happened to have mad typing skills (which totally killed it with the ladies, by the way).


  Intellectually, on the other hand, I was in over my head. I could get my name to scroll diagonally across the screen (again, catnip for the ladies), but, compared to my buddies, I was a pre-op Charlie from Flowers for Algernon.


  I don’t tell you this story to bore you. Although if it did, hey, Mission Accomplished! No, I bring it up to illustrate a pattern that has been with me since grade school and informs my experience with Linux.


  See, I have always enjoyed the trappings of tech-geekery without the underlying comprehension.


  I know, I know, I’m every enthusiast’s worst nightmare. I’m the guy who blithely clicks CONTINUE at the bottom of every screen during an OS install and then runs around the forums cross-posting in all-caps: “LINUTS JUST ATE MY FILES WHERE IS TEH WINDOWS NOW?!!!?! GET IT BACK, YOU GUYS!!1@!!! LINUTZ SUKZZZZZZ!!!


  But just as I played a crucial role in the Computer Olympiad, and much as a canary was once considered a key component in the coal mining process, I feel I have been placed on this earth to play a very special role with regards to Linux.


  I’d like you to think of me, not as the fashion-challenged “before” image in a weight-loss advertisement, but as an augur for Linux’s arrival.


  Let me explain.


  The first non-Microsoft, non-Apple operating system I ever tried was a sexy little number named OS/2. Yes, I know this was initially developed by Microsoft but I didn’t hear about it until the Warp era, by which time it was wholly owned by IBM so GET OFF MY BACK!
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  oooh, shiny!


  OS/2 Warp was pretty advanced for the time and competitive with Windows 95 (arguably much better). Later versions included Java, speech recognition, 32-bit windowing, Internet-compatible networking and *yaaaawn*look at the time, it’s getting late.


  No, the real genius of OS/2 Warp was that it treated operating systems the way Atari treats dragons. When Atari released Adventurefor the Atari 2600, they had this graphic on the box:
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  But when you popped that baby into the cartridge slot, this is how the dragon rendered:
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  In marketing, you sell the sizzle, not the steak. Atari did it with Adventureand IBM did with OS/2 Warp.


  OS/2 promised:


  
    	BREAKNECK BOOT UPS!


    	MULTITASKING MADNESS!


    	NUTTY NETWORKING!

  


  With such breathy promises of operating system sexiness, it’s no wonder that OS/2 Warp cornered the enthusiasts with few practical computing skills but a fondness for being mislead by marketingcopymarket. Which was, like, me and three other people.


  So I tried OS/2 Warp on a laptop and promptly borked the damn thing so badly I actually had to RMA the machine. I also returned the OS/2 Warp package and promptly invested the proceeds in AOL.


  And that should have been the end of it.


  But then, about twelve years ago, I started reading about Linux and the wonders of open source (seriously, no one has ever noted how much that sounds like “open sores?”). There was something familiar about the breathy promises and cult-like devotion, something I couldn’t quite place. Whatever, I bought a copy of Xandros on eBay and loaded it. Yeah, I bought it. Erm, let’s just say I hadn’t read all of the open source manifestos that carefully.


  Much like my last date with my first girlfriend, things started well enough. And then my mouse started acting hinky (a technical term referring to an inanimate object that becomes possessed by the ghost of a paint mixer). I got dizzy chasing my cursor around the screen, trying desperately to guess where I should click on one side of the screen in order to select something on the other side. I would have tried to fix the problem but there’s only so much effort I’m willing to put into this sort of thing. So, after about eight minutes, my experiment in alternate operating systems was over. Again.


  I demanded my money back from XandrosBoob98 and promptly invested it in Enron.


  And that should have been the end of it.


  But I could still hear the siren call and, over the next few years, I started playing with other Linux flavors. I became an open source slut, willing to have a go with any flirty distro that made eyes at me. I invited them all over to make out on the couch: Suse, Debian, Red Hat, Mint, Damn Small, and even a totally nasty one called #! that wanted to do stuff I had never even heard of.


  Each one had its own quirks, its own way of not working, and I remained unwilling to make a lasting commitment to any of them. I uninstalled each before they started leaving their stuff overnight and cluttering up my home (folder).


  I finally realized I had a problem when a friend caught me downloading a BSD .iso. I had gone too far. And I needed help.


  That’s when I discovered Ubuntu.


  At first, the breathiness turned me off. This distro would change things forever! It could be loaded on a toaster, ran on air and made you irresistible to the opposite sex.


  It was the sizzle again, and I was wary of buying the steak. But I had hit rock bottom and the next step was to sit around waiting for Hurd. I just couldn’t do it.


  I downloaded the Ubuntu .iso and ran it as a LiveCD. And the most amazing thing happened.


  It just worked!


  I don’t mean it ran my mouse but wouldn’t print from PDFs. I don’t mean it saw my video card but wouldn’t run Skype. I don’t mean it connected to the network but wouldn’t scan documents.


  It. Just. Worked!


  It was the equivalent of popping in the Adventurecartridge and having my eyebrows singed off by the dragon’s fiery breath!


  This is how I know Linux has arrived. If a guy like me, who wants all the flash of a pretty new operating system but can’t be bothered to learn what ‘ls’ at the prompt does, can find happiness, then so will most people, most of whom aren’t nearly as criminally lazy as I am.


  Fast forward to today. I’ve finally settled down with Ubuntu and we’ve had several laptops and one desktop together. It’s a happy home and I love my life partner even though the state of Virginia doesn’t see our union as legal.


  And now I think it’s time to give back to the community. I owe it to Ubuntu after everything it’s given me.


  Here’s my plan: I’m going to figure out some things, learn why some people swear by the command line, explore some of the available options and tools like virtualization, automation and personalization. I’ll look at these things from the perspective of a user who knows what’s cool about Linux but doesn’t always understand why.


  Think of me as the jerk down the road with a brand new Ferarri who doesn’t even know how to drive a stick shift. It’s time to look under the hood.


  Am I alone? Anyone else out there know how to summon the command line but fear its voodoo? Or maybe you get tired of answering the same questions over and over for new users. If so, contact me at copil.yanez@gmail.com. I’ll try to answer simple questions or point out helpful beginner advice from the perspective of someone who loves Linux and Ubuntu but doesn’t speak source code.

  


  
    BIO:

    Copil came to Linux via his lifelong interest in penguin-on-penguin erotica. His quest for the perfect fart joke is chronicled at yaconfidential.blogspot.com. You can also follow his stream of consciousness on Twitter (@copil).
  


  Making *buntu 12.04 Boot Faster

  Which factors do we need to take into account?


  by Alan Ward


  
    TWEET SCREEN FOLKS:Don’t worry, your half-finished project hasn’t been abandoned. Charles will return next month to finish off the Tweet Screen.
  


  The basic idea for this little piece actually came from a real-world situation I found myself in this last school year. An increasing number of fellow teachers are buying netbooks to use in class and at home. Their rationale includes, above all, the ease of transportation of these lightweight computers, though lower prices compared to regular laptops certainly do no harm. However, their initial enthusiasm tends to diminish slightly over time because of the lower speeds netbooks offer - which is when they come to me for advice. The dialogue usually goes this way:


  Teacher: I'm very happy with this new computer, but is there some way we could get a tad more speed out of it?

  Me: Which operating system are you running?

  Teacher: (whatever)

  Me: Hmmm... that won't be easy. Care to try Linux instead?

  Teacher: Will I be able to continue using Office documents?

  Me: Why yeah, sure. No problems with virus, either.

  Teacher: Suits me!



  As you can imagine, the end result of all this is a rising number of happy users. However, it has forced me to take some time to think out the choice of distribution to install on their machines. Being recent converts, they themselves usually had no preconceived preferences, but were happy to have me choose. Any version of Ubuntu seemed suitable - mostly for ease of installation and maintenance, though the availability of Catalan language translations was also a positive factor. But I think we can all agree not all *buntu distributions can get the same speed out of lightweight hardware.


  So I wanted to look at some hard data before coming out with a public recommendation – my professional reputation being at stake, so to speak. Evaluating available possibilities meant finding answers for the following questions, a process that I would like to share with you here:


  
    	Is there really a difference in speed between the various desktop managers? Is this a real difference, as opposed to merely a perceived difference?


    	What about the processor and motherboard? What influence do they really have on computer speeds?


    	Notebook hard drives do not have a good reputation. Is it important to take this factor into account? Could it be worth the time and money to upgrade the hard drive?

  


  To reply to all these questions, I needed a basic experimental protocol that could compare different distributions and computers, but that at the same time represented real-world user experience. Just measuring pure CPU speed or hard drive I/O performance, as most benchmarks do, was not good enough. But, on the other hand, what different people do with their computers can vary quite a bit.


  This is why I chose to measure something we all do: boot-up the machine. That is to say, I measured in each case the wall-clock time between the moment the BIOS starts loading the kernel, up to the moment in which the user can use the mouse to navigate through menus and get some actual work done.


  Most of my “experimentation” has been done with an early Acer Aspire One 10" (1GB RAM, Atom 1.6GHz CPU), though I made some comparisons with other hardware when needed.
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  Image 1: The equipment used for testing: a somewhat aging Acer Aspire, with (left to right) its own internal SATA-1 hard drive, a USB 2.0 pen-drive, and an 8GB class-10 SDHC card and its adapter.


  Though the article is aimed mostly at laptop users, specifically as regards getting the best user experience possible with netbooks and not-quite-bleeding-edge types of hardware, I hope it gives the reader some practical ideas that he or she can try out in other areas as well. Enjoy!


  The desktop manager


  Though Ubuntu and its derivatives have a reputation of going easy on system resources, this may vary across versions. For example, Kubuntu users' practical experience is that to get a responsive system, you may need some relatively serious power under the hood, specifically in the graphics card department, otherwise you may need to deactivate some of the more funky desktop effects. This may be a show-stopper for the more impatient, who move on to other less beautiful but more speedy desktop managers – been there, done that. On the other hand, Lubuntu is often touted as a more streamlined desktop, suitable for older or less powerful hardware.


  The general perception I get – from reading around and my own experience – is that we could probably classify the better-known desktop managers in the following order (from slowest to fastest):


  
    	Kubuntu, with the KDE plasma desktop manager.


    	The Gnome 3 desktop manager. It is not, for the time being, installed by default by any of the *buntu distributions (though it is the main desktop for some versions of Linux Mint).


    	Ubuntu, with the new Unity manager.


    	Xubuntu, with XFCE 4.


    	Lubuntu, with LXDE, also a relative newcomer to the playground.

  


  So, what truth is there in these user perceptions? I needed some hard data to base my decision on.


  The first step was to perform a standard installation of Ubuntu 12.04 for i386, update it to the latest versions of all software packets, and then add the other various desktops:


  
    # sudo aptitude install kubuntu-desktop
  


  etc.


  It may be interesting to note that the finished system occupied just above 5GB, not that much more than the standard single desktop installation of 3GB.


  I could then start measuring boot-up times. Perhaps it should be noted that these times are a combination of:


  
    	the time it takes the kernel (a vanilla 3.2.0) to load, loadinitrd, and switch roots;


    	the time is takes the initprocess to set up shop (go multiuser, load daemons, etc);


    	the time for the Xorg windowing system to detect graphics hardware and switch screen mode and resolution


    	finally, the time needed for the desktop manager to load its own libraries and display the user's GUI environment.

  


  The first three steps are identical in all cases, and add up to about 20-21 seconds on my test hardware. So differences in total boot times are due only to the actual window manager. Total boot times were:
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  As can be seen, the short answer is: yes, the choice of desktop manager is definitely important as regards speed. Basically, I obtained the same type of results as have many others, with Lubuntu and Xubuntu variants of Ubuntu giving rather good results, though with a slight edge for Lubuntu. The standard Unity desktop was a nice surprise, coming in third with a small 6s lag compared to Lubuntu. Gnome 3 still seems to need a bit of tweaking for performance, while KDE - with standard effects activated -is not a fast mover, needing 22s or 73% more time than Lubuntu to get to the same point of being able to do some actual work.


  Please note that these differences are further accentuated on a memory-starved computer. I would not recommend less than 1 GB of RAM for either Gnome or KDE . Boot-up times can easily double with 512 MB of RAM, and the machine is not at all responsive during use. Things are perhaps not quite as dire for Lubuntu or Xubuntu, though the difference is still noticeable.


  The processor and motherboard


  It seemed reasonable not to give much importance to our CPU and motherboard, since we cannot easily change them on a laptop: we are in general stuck with whatever we have. However, since we do have some say in the matter when buying a new computer, let's take a quick look at the effect these elements can have on our speed.


  To do so, I took the same internal SATA hard drive from the Aspire, and used it to boot a series of computers with increasingly powerful processors. The first two were laptops, and the last a desktop unit. Boot times were:
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  As could be expected, a faster CPU does seem to help boot faster. However, all other variables (hard drive and RAM) being equal, boot times are not that much faster between a single-core mobile Atom processor and the - in theory - more potent desktop dual-core. Based on pure CPU computing power, we should be looking at speed increases to the tune of 110% for the Centrino and 260% for the Dual-core, which is quite visibly not the case.


  This is in fact an interesting development, since it gives us the idea that our boot process is limited more by the speed of our disk drive than by that of our CPU. Using the language of high-performance computing circles, we would say that our process is “I/O bound” (as opposed to “CPU-bound”). From this we can tell that it may be more interesting for netbook or mobile users to invest in hard drives, rather than in top-spec CPUs.


  As a side-note, perhaps we should remind ourselves that we have just been measuring boot-up times. Our results may or may not be extensible to normal light computing (browsing the Internet, or working with office programs). But they cannot be taken as a valid benchmark for more CPU-intensive tasks such as scientific number-crunching or gaming – areas where CPU speed does make the difference.


  The boot medium and partition


  Since we found that the CPU and motherboard are not that important for our purposes, our third and final step was to see what effects the physical drive could have. Since GNU/Linux is a modular operating system, it is in fact rather easy to boot from various media. Basically, if your BIOS can boot it, GNU/Linux can probably use it. For a bit of variety, I used:


  
    	the original internal hard drive, a SATA 1 unit;


    	an external 2.0 USB pendrive;


    	an SD memory card.

  


  Before continuing, perhaps we need to examine further what these are capable of. The actual speed a hard drive is capable of giving us is a combination of bus speed (i.e. its connection with the motherboard), the signaling speed the drive and motherboard agree upon, and finally whatever speed the drive itself is physically capable of. Just to complicate things, this later number can vary. For example, flash-based drives are always way faster reading data than writing it to disk. This is inherent to the NAND or NOR flash chip technology they use.


  This is why the 1.5 Gb/s (about 150 MB/s) transfer speed of the SATA hard disk is merely theoretical. This is a bus speed, that most current spinning-platter laptop hard disks are incapable of using up completely (solid state disk are another matter). All the more so in our case, when the Acer's motherboard and the hard drive agreed on using the ATA-8 signal protocol, or UDMA/100. This means we are down to, at most, 100 MB/s with this disk. As to physical speed, I have tested the disk at about 83 MB/s, which is not too bad for a 5400rpm unit.


  On the other hand, the SD card uses the appropriate reader hardware, which is connected to the internal USB bus in a similar way to the keyboard and touchpad. But not all SD cards are equal in speed. This was a class-10 unit, guaranteed to give at least 10 MB/s in write speed. Since it has a theoretical USB 2.0 speed limit of about 60 MB/s, we can hypothesize that its read speed is about that figure. To all intents and purposes, this format is equivalent to the more classical USB 2.0 external pendrive. In fact, my USB pendrive has a slower write rating, so I concentrated on the SD and left the pendrive out of the equation.


  To my mind, the internal hard drive and the SD card represent just about the respective best and worst physical speeds available for our test computer.


  At the same time, I also wanted to know if using a primary hard drive partition (/dev/sda1) or an extended partition (/dev/sda5) had any effect at all. This is what I got:
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  The basic hierarchy between desktop managers seems to be respected in all cases. However, it is clear that using a faster drive will help all desktops boot faster. The gain in speed is not quite proportional to theoretical line speed, but it is there nonetheless. That being said, it is also clear that even using the slower SD card (or equivalent USB pen-drive), lightweight desktops such as LXDE can still boot within reasonable times.


  What is more interesting is the difference in performance between primary and extended partitions on the internal hard drive. We can see that using an extended partition on the internal hard drive is not a Good Idea (TM), since boot speeds of the internal drive actually drop below those of the SD card. This came as a bit of a surprise, and (I think) can be explained only by the fact that the extended partition may require twoseekoperations each time a read is requested by the system: one to access the primary partition it is hosted in, and the second to actually access data. This is definitely something to bear in mind when we partition our drive.


  OK, so if having a fast drive and a fast connection between drive and motherboard is good, what could be better? It seemed reasonable to try using two drives, on two different connections, at the same time. If both drives hold the same information at all times – a technique variously known asmirroringor RAID level1 – then we can hope to double our read speed. This should definitely help shorten our boot times.


  Additional hard drive caddies are appearing for many laptops (they replace the CD/DVD combo), and most desktops have space to fit in an extra hard drive or three. But this is not an option for netbooks, so I had to get back to the desktop Dual-core machine for this step. I used a single internal 3.5”SATA-1 hard drive for one set of tests, and two identical drives with the root partitions configured as a software RAID-1 array for the second.


  This is in fact a rather funky setup where you need:


  
    	a small non-RAID boot partition (let's say /dev/sda1) to contain the /boot directory for the GRUB boot-loader to read kernel and inirtd file from;


    	alarger RAID-1 partition that combines a physical partition from each hard drive (for example, /dev/sda2 and /dev/sdb1), that will be mounted as the filesystem root / directory.

  


  If you are interested in this technique, it is probably something you should play with a bit on a not-so-important computer before setting up a production machine. Anyhow, I got these results:
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  As expected, we can now confirm that faster hard drives make for shorter boot times. This is even more noticeable for the more heavyweight desktop managers, that seem to need more disk activity to set up. System responsiveness is also nice and crisp during use, so this looks like an interesting path to follow on computers that can contain the extra hard drive we need to do RAID.


  Conclusion


  After making my poor old computers jump though these loops, I am beginning to get a clearer picture about what is really important to speed up *buntu desktop boot times. To sum it up:


  
    	Yes, the choice of desktop manager does make a difference. There is less of a gap between the ultra-lite LXDE and XFCE desktops and Unity than I expected, which go to show that Canonical's efforts in this sense have not been in vain. Unity is in fact not a bad choice for a lowly netbook, though if we really need more speed, Lubuntu or Xubuntu are the way to go.


    	The processor and motherboard are not quite as important for normal user experience. This is not to say we should skimp on either, but rather that the difference in price between an entry-range processor and a faster chip may not be noticeable if all we do is boot the computer, navigate on the Web and do presentations. Otherwise, things may be very different ... and perhaps you could do some experimentation of your own before choosing your next laptop.


    	The key factor in speeding up boot times is simply the hard drive, or rather (and not so simply) the combination of hard drive, its bus connection to the motherboard, and partitioning.

  


  My takeaway from all this is that it may be worthwhile to take a hard look at your hard drive (no pun intended!), and try to optimize its speed. Are we booting from a primary partition? Which version of SATA does the computer support: is it a SATA-1 at 1.5 Gb/s (about 150 MB/s), or a SATA-2 at 3 Gb/s (about 300 MB/s)? Try to find an internal hard drive that can really sustain this speed.


  For laptops with an optical drive, hard drive caddies that replace the CD/DVD with space for a second hard disk are becoming more common, with prices in the $40 - $60 range. So RAID-1 on your laptop may be a choice, especially if you already have a spare hard drive lying around.


  Finally, USB 3 ports with their 5 Gb/s (about 500 MB/s) line speed are also becoming more common nowadays - even on netbooks - and allow an external hard drive to boot up a computer at practically the same speed as an internal drive. So it may be worthwhile to choose your next netbook with one of these, in the interests of future expansion.


  To end on a more personal note, allow me to present my personal desktop. Using the perhaps ancient - but still beautiful to my eyes - FVWM Crystal desktop manager, it makes the Acer boot up at a fast-ish 26s (compare to LXDE at 30s). However, with its distinctly "geeky" feeling, it may not appeal to all tastes.
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    BIO: Alan teaches computer science at Escola Andorrana de Batxillerat (high-school). He has given GNU/Linux courses at the University of Andorra, and currently teaches GNU/Linux systems administration at the Open University of Catalunya (UOC).
  


  Closing Windows

  File/Folder Sharing


  [image: ]


  Folder sharing in Windows XP is relatively simple. It’s done by right clicking on a folder to get its properties then, in the sharing tab, give it a share name and (if needed) a comment. Unfortunately it’s not always that simple in Linux. In recent years though, Ubuntu has made folder sharing just as easy, but that can also depend on which desktop you use.


  Kubuntu


  Almost identical to Windows XP in that you right click a folder, choose properties, then click the ‘Share’ tab to gain access to folder sharing.
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  In this tab you can check the box (if required) to share with Windows, give the share a name, allow/disallow guests and whether to allow full control, read only control or deny on a per user basis. If you don’t see a ‘Share’ tab (and you’re not asked to do so) you may need to install SAMBA using your package manager.

  Should you need to assign a login/password to your network (and I think you should) this is set in K > System Settings > Sharing >

  To connect to a Windows machine you open Dolphin (the KDE file manager) and click Network (in the left panel), then Samba Shares, finally Workgroup, and you should now see a list of available machines to connect to. Double click the machine and you’ll see the list of shared folders on that machine.
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  Note that above the folders you see smb:ronnie-desktop - that smbmeans SAMBA and reminds me that I’m browsing the network.


  Gnome-Shell and Unity


  The Gnome-Shell variant also uses Samba to connect to other network components. This means when you want to share files and/or folders over your network you need to have Samba installed.


  When you right-click a folder in the file-manager which you want to share, a drop-down menu appears and one of the possible choices is Sharing Options. When you choose this item and
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  Samba is not installed, you receive a message you need to install it.
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  Installing is easy, just follow the wizard that guides you through the installation process.


  Installing Samba has one downside: you need to reboot afterwards so the program can read the config file and knows what to do and how to do it.


  Once Samba is installed and the computer has rebooted you can return to the file-manager and right-click the folder you want to share. Click Sharing Options again, tick the tickbox “Share this Folder”, choose a good name for the share, decide if other users have the right to create and delete files in the share and if non-registered users have access. Finish with the button Modify Share.


  Now it should be possible to open Network in the left column of the file-manager, choose workgroup and see which computers are online and which folders they have shared.
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  Once shared, the icon of the shared folder shows a double arrow indicating data can flow both ways to and from the folder.
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  Xfce


  The Xubuntu desktop with Xfce comes with Thunar as a file manager, which currently does not offer direct access to manipulating the sharing properties of files and folders. There is currently a thunar-shares-plugin project, but it is not packaged for Xubuntu at this time so has to be installed from source and manually configured, the author has not tested it.


  Instead, you can install samba manually and configure it to serve the folders you wish to share. Alternatively, you can install a file manager from Gnome, called Nautilus, with sharing by installing the nautilus, nautilus-share and samba packages. You can then launch Nautilus and navigate to “Sharing Options” for the folder you wish to share, just like you would in Gnome-Shell.


  LXDE


  Once again, in keeping with the “light-weight" nature of Lubuntu, the default installation does not include the software to facilitate file sharing; however, as with all other “optional" applications in Lubuntu, all the software required to share files (e.g. NFS support, Giver, Samba,etc.) between multiple Linux boxes and/or Linux and other OS’s (e.g. MS Windows, OSX, etc.) is readily available from the repositories. Also, the lightweight file manager that comes standard with LXDE - PCManFM - has no default integrated capabilities to allow you to configure the sharing of files or folders; however, if Samba is installed, then you can access and navigate Samba shares directly from within PCManFM by typing the IP address of the target Sambashare into the address field in PCManFM.
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  Also note that if you choose to install Samba and/or NFS support, then you can not only manage file/folder sharing with those packages’ respective management tools (and from the command line, of course), you can install the very small and simple Lubuntu Control Center (LCC) application which, among other things, provides a very simple and fast utility to create/manage shared folders.
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  You can certainly install LCC even without file sharing installed so that you can benefit from its other features; however, if you click on the Share icon in the LCC, then a dialog box will pop up notifying you that you do not have file sharing services installed and it will offer to install one or more services for you.
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  It should be obvious by now that the “tag line” for Lubuntu (and most other “lightweight” distros) is “It can change to meet your needs”. If you are looking for a “lightweight” distro, then you should expect to have a “stripped down model” [of Linux]. That’s why you chose a lightweight distro in the first place, right? (The answer is “Yes”.) But because most of these distros (like Lubuntu) were made “light” by eliminating lots of “software overhead” and by using utilitarian equivalents to basic (and indispensable) applications like file managers and web browsers, you are free to “fatten them up” to your heart’s content from the repositories. Of course, if you wanted “fat” to begin with, you wouldn’t have chosen a “lightweight” distro in the first place. But it is important to know that as your needs change and you require functionality that is not available in Lubuntu by default, it is immediately available to you via the repositories. This “malleability” of Linux is one of its greatest strengths and accounts for the myriad “shapes and sizes” of Linux distros available. And let’s not forget that none of this would be possible without the open source development model.


  My Story


  by Fredrik Johansson


  Ive been a computer user for most of my life. Being born in the latter half of the 80s, that is to be expected. The computer was solely for entertainment, and for playing games in particular. In the late 90s, we got access to broadband Internet, we had dial-up for years before but, due to the cost, I rarely got to use it (and, when I did, I used it to look up gaming guides and cheats). Broadband access changed how I used the computer drastically, napster helped with that too. I didnt care that my computer was too slow to run the newest games any more (I bought a video game console to satisfy my gaming needs), because I could explore this whole other world and interact with people in a way that wasnt possible for me before. I was still using Windows however  it took me a long time to get rid of it actually. Ive been running Linux-based operating systems for two years now, and I dont see myself ever going back.


  In 2010 I fell in love. I fell in love with the demo scene, and more specifically the synth and tracker driven music. I had occasionally stumbled across a demo or two, cracktros and so forth, but I never thought much about it. Music has always been a big part of my life, and I do consider myself as someone who doesn't care about the genres as long as it sounds great (youll probably argue with me about that if you have a look at my collection, though). In the early years of high school, I was very into metal, and I thought that Iron Maiden was the greatest, but, as I matured, so did my musical taste. One day I found this album called First and Last and Always. I thought the first few tracks were ok, then track #5, Marian, begun playing and completely blew me away. I still refer to The Sisters of Mercy as my favourite band.


  But something else also happened in 2010. One of my hard drives gave up, and with it went my music collection. On the bright side, I finally decided that I was done with Windows and Ive been running Linux ever since. I stuck with Ubuntu until 11.10, I thought Unity was awful and switched to mint 12, and now Im running mint 13 64-bit MATE on both my desktop and laptop.


  So what does Linux, the demo scene, and music have in common? For me its Subsonic. When I lost my music collection (except for the Sisters of Mercy albums which I actually own), I started downloading all the amazing free demo scene music, and it soon led me into the wonderful world of net-labels. To this day, I still cant believe how much incredible brilliant and wonderful music theres out on the Internet, for free! This is where Subsonic comes in. As my music collection grew exponentially in size, and the wide range of different audio formats made it impossible to carry with me everywhere, I had to find a solution. With Subsonic, it doesnt matter if the file is an .xm .mp3 .flac or .aac  itll transcode (into a bit-rate of my choosing) it all into something that my Android device can play when Im out and about. When Im at home, I use the web interface to access all my music, I have not yet been ableto get the right equipment to set something up for the jukebox function. Which means that the computer running the Subsonic server is outputting the music through its audio ports and the playlists are controlled by an external player.
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  Subsonic is free, but with additional features unlocked if you donate, such as being able to play your files on an Android device, and video support. The installation process is pretty straightforward, its distributed in a .deb package, and that makes it easy to install. And, if you need additional help, then take a look at the forums, a lot of great tutorials there.


  Installing Subsonic as a linux newbie taught me a lot. The first few weeks of using Ubuntu, I wasnt sure I was going to stick with it, I felt as if everything I did could be done just as easily (and in some cases easier) in a Windows environment, and the terminal scared me. I had picked up some basic terminal commands back in school (cd .., ls, cat, nano, man, etc), and little by little I began exploring and tweaking config files to my liking. My current Subsonic server is running on Ubuntu Server 12.04, a couple of old hard drives in an old computer running in RAID 5. I have sshfs (SSH Filesystem) running on it, so I can use it as my own personal cloud storage, and adding more music is a breeze.


  So, what do I want to say with all of this? If youre having trouble getting into Ubuntu (or Linux in general), think about what really drives you, whats your passion? Chances are someone has written neat software that will make your life  and the exercising of that passion  a lot easier. Dont be afraid to use Google or the man command, theyll be your best friends. Be prepared to read a lot, most guides Ive come across have a good description of what every single command and parameter does when theyre executed, thats how youll learn.


  Why I left Windows.


  by Eric Porter


  Windows 3.0 was released in May of 1990, just one month before I graduated from high school. Previous to this, my experience with computers was limited to DOS operating systems and good old fashioned Tandy Basic, with a smattering of machine code here and there. Needless to say, for me Windows was a godsend, and I remained a faithful little fan-boy all the way up through Windows 98, where for financial reasons I stayed until the release of Windows XP.


  [image: ]


  XP was missing a few of the features I liked from '98. It had some new quirks I had to get used to. And, until they came out with service pack 2 it was rather unreliable. A few years go by and they finally get done shaking all (well most...) of the bugs out of XP just in time to release a new version called Vista. It was supposed to be faster, stronger, and just better in every possible way. They even beta tested the thing so it had to be good. Right? So, naturally, I ran right out and bought myself a new desktop, set it up and hit the power button. I didn't know it at the time, but that was the beginning of the end.


  I could bore you with all the details about the massive amount of software incompatibilities, the BlackICE Defender program that constantly questioned everything I did, the glitches, jams and downright frustration of it all. But, I am sure that many of you have experienced them for yourself, so there's no real need. I think what I found most frustrating, however, was how much it seemed to coddle the user. It looked and felt like it was designed for toddlers. It forced features on me that I didn't even want, and those features that I did want were gone. Even most of the desktop customizing tools that I was used to using were now a ghost of the past.


  Three short months later it crashed. Hard. Total meltdown. It was inevitable, I suppose. It was Windows, after all. So, like a good little MS drone, I set about the all too familiar task of reinstalling the OS. 30 minutes later I get this lovely blue screen that read, We're sorry, this computer is not compatible with Windows Vista. Say what now? IT CAME WITH VISTA! Several unsuccessful tries later I had had it. I installed XP, fired up Explorer, made my way to Google, and typed Windows Alternatives.


  Thus began my exploration of this strange new world of Linux. I must have tried out 20 different distros and flavors. Some more than once. I finally settled on Ubuntu. It was the highest rated, most download, best reviewed, and most intuitive distro I found. After bouncing around between the three main desktops (Gnome, KDE and XFCE) for about a month I finally committed to Gnome because it was the most comfortable for me coming from a Windows OS background.
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  My first full install was Ubuntu 7.04 LTS with the Gnome desktop. It was freedom, Baby. I could finally make my computer look how I wanted, and act how I wanted. I must have completely rebuilt my personal desktop 1000 times in the last 5 years. My wife is terribly grateful for her own Login, I'm sure, as I am constantly fiddling and tweaking and revamping. It's so in tune with my artistic nature, and the possibilities are seemingly endless. It's been everything to me that an OS should be. It's intuitive, responsive, logical, and, mostly, it gets out of the way and lets me do what I want.


  I've since installed every LTS version of Ubuntu that came out. Which naturally includes Ubuntu 12.04. I have to say, that it came as a bit of a shock to me when I saw the Unity desktop come up instead of Gnome. At first, I thought I had accidentally downloaded the wrong ISO. I hadn't. So, I gave this new desktop a trial run. After all, there's nothing wrong with change, if it's for the better. Unfortunately, this wasn't. It was cumbersome, counter intuitive, and slow. I think what I found most frustrating, however, was how much it seemed to coddle the user. It looked and felt like it was designed for toddlers. It forced features on me that I didn't even want, and those features that I did want were gone. Even most of the desktop customizing tools that I was used to using were now a ghost of the past... Now, where have I heard this before?


  Don't misunderstand. I'm not kicking Ubuntu to the curb just yet. I've found a desktop thatworks o.k. for me (Gnome classic... with quite a few tweaks added). But, I cannot help but question the wisdom behind the move to Unity. By swapping to Unity, they not only alienate their current fan base, but potentially alienate themselves from new converts who are used to a Windows style interface which has been around for 20 years. If we want to attract new users, we have to make that conversion easy and natural for them. Gnome accomplished this. Unity does not. I find it insanely ironic that a desktop environment which causes so much confusion, disharmony, and division is named Unity.


  Review of Software :

  gPodder Podcast Client


  by Tushar Bhargava


  Most people prefer to use their default music player for managing their podcasts. However, gPodder is a stand alone podcast manager that might offer a much better podcasting experience. gPodder is an Open Source (GPL Version 3 or higher) podcast client made by Thomas Perl, an Austrian programmer. gPodder was created in 2005 with the modest aim of downloading and managing podcasts. It was earlier written in Java using the Gtk UI but has since been ported to Python. It currently uses the PyGtk and Gtk2 UI which gives it a nice Ubuntu look and feel. Global Menu support gives it an almost perfect Ubuntu integration. However, Unity integration is still missing.


  The graphical user interface is simple and intuitive. The main features are visible at a quick glance. gPodder offers you the options to download, play or transfer your podcasts. When you choose to download a podcast gPodder carries out the download quickly and unobtrusively in a separate 'Downloads' tab. You can set various limits on the download speed and number of simultaneous downloads. On clicking the 'Play' button gPodder opens your default music player to play the podcast. You can choose which media player gPodder calls in the 'Preferences' entry of the main menu. gPodder also allows you transfer your podcasts to an iPod, MTP, file system or bluetooth based device. These options cover virtually all the devices you might own. This feature, though much loved by gPodder users, is missing in version 3x and it is for this reason that the version in the Ubuntu Software Center has not been updated. If you want the device sync feature stick to the older 2.x version.
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  gPodder supports a wide variety of formats including RSS, Atom, YouTube, Soundcloud, Vimeo and XSPF feeds. It allows you to add podcasts from a URL or to import them from an OPML file. It enables you to export your own OPML file which makes it relatively easy for you to share your podcasts with others or set up a podcast client on another computer.


  Despite its simple and easy to use interface gPodder has its fair share of advanced features that can be found under the 'Preferences' entry in the 'Podcasts' menu. gPodder allows you to set an 'update interval' to check for new podcasts. It allows you to set limits on the number of podcasts per subscription. It also offers various actions to perform if a new episode is found. In addition to this, gPodder allows you to set your own rules for 'clean-up'– which podcasts to delete automatically (if at all) and which to keep. Lastly, gPodder offers fairly comprehensive features to sync your device with it. It allows you to select which episodes to sync and which episodes to remove from the device automatically.


  gPodder has one final ace up its sleeve – its seamless integration with gPodder.net. gPodder.net is a podcast web service that not only allows you to discover new podcasts but also share your favorite ones. It allows you to remotely manage your gPodder subscriptions and provides a place to backup your subscriptions. It also makes it very easy to set up gPodder on another computer.


  gPodder is widely considered as one of the best podcast clients. It has received mainly positive user reviews and has a 4.5 star rating in the Ubuntu Software Center (at the time of writing). It was also listed by Lifehacker as one of the 'Five Best Podcast Managers '. 


  gPodder is a cross-platform application that is available for Linux, FreeBSD, Windows, Mac OS X and mobile devices like the Nokia N810, N900 and N9 (which run Maemo or MeeGo). An experimental version for Android is also available. Get gPodder at http://gpodder.org/. Happy podcasting !
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  The Good


  
    	Extremely easy to use with a simple and clean GUI


    	Lightweight and fully native to Ubuntu


    	Powerful advanced features for power users


    	Device sync (not available in version 3.x)


    	gPodder.net integration makes managing and finding podcasts easier

  


  The Bad


  
    	Lack of built-in music and video player


    	No Unity integration


    	No system for rating the podcast episodes

  


  Rating: 4.5 out of 5 stars


  Don’t forget to add the Full Circle Podcast,whichever podcasting client you use:


  [image: ] RSS feed, MP3:

  http://fullcirclemagazine.org/category/podcast/feed


  [image: ]RSS feed, OGG:

  http://fullcirclemagazine.org/category/podcast/feed/atom

  


  
    BIO: Tushar Bhargava is a 16-year-old Indian who loves Ubuntu and FOSS. He likes to program in Java and C++ and enjoys writing. Contact him attushar1995@gmail.com
  


  Letters


  You Want Game Reviews?


  Just thought I'd inform you of a book/presentation I have been working on for the past couple of years as a side hobby. It covers roughly 400 games found in USC and Synaptic PM (none of the fatties, just the usual suspects).


  Couldn't publish it as an epub because it didn't fit formatting rules (over 800 pages and in PDF instead of docx or odf), so I packed it off to lulu.comas a cheap $1.50 book. In addition, due to included screenshots, it came in at over 15MB.


  There are about 550 games in USC, but some don't work or are actually old hangers on that have been given new names and posted elsewhere. I hit maybe about 60% of the games out there. Oh, and I should clarify that I did it via LibreOffice Impress, so it's one page containing a screenshot and one page with the URL, general info, and USC rating, if any.


  Lulu address for the book is:

  http://www.lulu.com/author/content_revise.php?fCID=12986866


  Art Schreckengost

  


  Quick DVD Backup


  May I suggest a trick that delivers a properly installed and clean Ubuntu – otherwise it could contain a lot of waste after repeated program installs and uninstalls.


  After installing an Ubuntu distribution with all necessary components and cleaning the surplus ones, I use the remastersys program to make a system backup ISO file, and burn it to a rewritable disk to make a Live DVD with username and password, but without personal data.


  This Live DVD could be used for experimental program installations, while using the same system as the one installed to the HDD. With 4 GB RAM, some 1.7 GB to 1.9 GB additional free space could be made available.


  This way, I can run tests without any risk of leaving any waste on my installed system since, after rebooting with the Live DVD, I have a clean system again. Based on the results of the tests, I can then be confident that the tested programs will also install and run correctly on the HDD system.


  Using this approach, I can successfully try some Amateur Radio programs, both .deb extension Linux and .exe extension Windows ones (among them SSTV, PSK31, etc.).


  Moreover, I can surf the Internet without any risk of infection since the DVD is write protected and the RAM memory will be empty after shutting down the computer. If I download any file then it can be saved directly to a pen-drive or to an external HDD after checking it with the "Clamav" anti-virus program already installed on my Ubuntu operating system (and refreshing its database from the Internet).


  I was using an older computer without a built-in HDD, and the computer was used exclusively with a Ubuntu Live-CD and with a broadband internet connection. This was the less expensive computer I had!


  András Szabó

  


  My Bad! Sort Of...


  I have to apologize for not sending in those reviews I promised, here’s the reason why. After I built my new pc system – moving from an AMD cpu to an Intel Ivy Bridge – I then installed 12.04 LTS, and, long story short, it was a complete disaster. Robin reported 12.04 instabilities on his blog a few weeks ago, at the time I was on a AMD 64-bit build and had no problems. The moment I switched to an Intel system it was problems galore with random freezes, crashes, etc from nautilus to firefox, chrome, gwibber – even the software center would crash! You can read more about it here (https://bugs.launchpad.net/ubuntu/+source/xserver-xorg-video-intel/+bug/993187). So, for a few weeks I could do nothing more than browse the web trying to figure out what was wrong before the system went crazy – and I had already given away the AMD system. Please post the solution to this (https://bugs.launchpad.net/ubuntu/+source/xserver-xorg-video-intel/+bug/993187/comments/91) for people who may be experiencing the same problems with the latest Intel architecture. Meanwhile, I will get started on those reviews I promised.


  Dougn Redhammer

  


  Unity, Mint and Tablets. Oh my!


  I have been using Linux Ubuntu for about 4 years and do not use a Windows dual boot. I do have a Windows machine for a couple of programs, but have “almost” managed to eliminate this necessity with Wine.


  I was using Ubuntu up to version 11.10 with the Classic login. The Classic login works on Laptops/Desktops, but you are stuck with Unity if you have a net-book. I have an Asus Netbook with 2GB RAM and a 250GB hard disk. I use this a lot while on the move, and got enticed to Linux Mint 12 from articles in other Linux magazines. I installed Mint on my netbook and it even recognized the extra touch-pad button to turn it on and off. Ubuntu did not recognize this button. I also installed Mint on two other high spec laptops and... so far so good.


  Now on to the Unity-Windows 8-Tablet debacle, so clearly described in the FCM60 article by Art Schreckengost. I can understand why Canonical is going the Unity route as this is the way Windows 8 is heading. It is aimed at tablets, touch-screen computers and TVs. I have an HTC Android mobile phone, which is great and very convenient, with its touch screen, but I cannot see myself swiping the screen of a laptop. On several trips to computer and mobile phone shops, I have checked out the non-Apple tablets on the market. The tablets on sale are very confusing as some have a USB port, some don't. Some have Bluetooth and some don't. They all have a reduced storage capacity and memory. Some are cheap but in general they are very expensive. As someone who is somewhat of a gadget freak, the tablet is one piece of technology that I have not rushed out to buy. Why buy a tablet, with reduced characteristics, when you can get a high spec netbook at a better price. My netbook does all that my laptops do, with the addition of an external DVD drive. In my opinion the tablet is not going to last in the market.


  Allan Hambidge


  Q & A


  compiled by Gord Campbell


  
    	When I tried to install Sopcast in Mint 13, the repository was not found.


    	
      Run this command:


      
        gksudo gedit /etc/apt/sources.list.d/ferramroberto-sopcast-maya.list
      
In the first line, replace "maya" with "precise". Save and exit. In Synaptic, reload the sources.
    

  


  
    	I have a Samsung R580 laptop running Ubuntu 12.04. When I plug in my HDMI cable to connect it to the TV, I can't get the sound through the TV.


    	From the volume control in your panel, run Sound Settings. Select the Hardware or Output tab. Select one of the HDMI devices. If that doesn't work, keep going though the HDMI devices. (HDMI/Display Port 4 from Sound Settings -> Output was what worked for this laptop.)

  


  
    	I have just installed Ubuntu 12.04 on a Dell Latitude 2100. I installed the Broadcomm driver and configured my hidden wireless network. All is well. However, if I run the netbook on battery the wireless network speed decreases drastically.


    	(Thanks to taylorkh in the Ubuntu Forums)The solution was the second suggestion on this web page: http://askubuntu.com/questions/85214/how-can-i-prevent-iwconfig-power-management-from-being-turned-on.

  


  
    	How can I install the latest version of the Openshot video editor?


    	Have a look at this page: http://www.openshot.org/ppa/

  


  
    	I have a 4 page PDF, I need to delete pages 2, 3, and 4.


    	Try PDF Shuffler. You can get it from the Ubuntu Software Center.

  


  
    	Thanks for your help, but my network has a WEP key, do you have to write something different if you have a WEP key?


    	(Thanks to Chili555 in the Ubuntu Forums)Yes: you log on to your router and change it to WPA2. WEP is about as secure as putting your credit card in a shoebox on the front porch.

  


  
    	How can you remove a program and all the files? I did:



    	
      
        sudo apt-get purge remove quassel
      

    


    	(Thanks to papibe in the Ubuntu Forums)'remove' conflicts with 'purge'. You need to use just the 'purge' option.

  


  
    	Will UEFI kill Linux?


    	UEFI is OK. Secure Boot is one of its features, and it may become a problem for some Linux distros. Have a look at:

    http://blog.canonical.com/2012/06/22/an-update-on-ubuntu-and-secure-boot/

    Secure Boot might even be beneficial, if it reduces the number of "here today, gone tomorrow," Linux distros.

  


  
    	How can I turn off the overlay scrollbars in Ubuntu 12.04?


    	This web page tells all: http://www.liberiangeek.net/2012/03/disable-ubuntu-overlay-scrollbars-in-ubuntu-12-04-precise-pangolin/

  


  
    	How can I have multiple VPN connections at the same time?


    	See this page: https://www.facebook.com/pages/Ubuntu-Problems/181849281895067

  


  
    	In Ubuntu 12.04, after upgrading to the 3.2.0-25-generic kernel, I no longer have any sound. Hp pavilion dv6.


    	
      Open a terminal and enter this command:


      
        gksudo gedit /etc/modprobe.d/alsa-base.conf
      
Add the following line at the end:


      
        options snd-hda-intel model=dell-m4-1
      
then reboot.
    

  


  
    	I installed a game in Wine, and it put about 30 icons on my desktop.


    	Move the installer program from Desktop to another folder before you run it. Downloads/nameofgame is a good choice.

  


  
    	I have a webserver which is running Linux Ubuntu 8.04.4. I would like to install the grads service.


    	(Thanks to Coffeecat in the Ubuntu Forums)Upgrade to 10.04, and grads is in the repositories.

  

  


  Tips and Techniques

  Why Can't Billy Install Ubuntu?


  I respectfully suggest that this is an education issue, and technology can only solve a bit of it.


  Here are my top three reasons Billy can't install Ubuntu, or any other version of Linux:


  
    	the computer is set to boot from the hard drive, and Billy can't or won't change this,


    	installation requires changes to "partitions," and Billy has no idea what those are,


    	there's a driver issue, and everything Billy knows about drivers no longer applies.

  


  I have a good friend who knows a lot about computers; over three decades, he has used them, sold them, written about them. When I suggested that he would need to go into the BIOS settings and "change the boot order," so his computer could boot from CD or flash drive, that was the end of any talk of trying Linux. He's not sure how to do it, and he has been warned that he could really mess up his computer by changing BIOS settings. It's true, too. Stroke a bunch of random keys and select "save," and you might need to take the computer back to the dealer, just to get it to run.


  [image: ]


  If someone asks me how to change the BIOS settings, I can't provide a good answer, unless I have a computer identical to theirs. I've been lucky; turn on my computer and press Delete, and I'm into the BIOS settings on every computer I have owned. On other computers, you need to press ESC, a function key, or something else. There is no industry standard! Many computers do not display what key to press, nor does the information appear in the manual.


  Once you're into the BIOS settings, you need to read what appears on the screen to figure out what to do next, and you often need to press the "down" key and read what appears, until you discover the magic. Even the method to change the boot order, once you get to the correct screen, is not standardized.


  If I had information about your computer, at a grotesque level of detail, I could write a program to make it boot from CD or flash drive. However, I couldn't write a program to make every computer boot from CD or flash drive. There are just too many of them, and new ones appear every day.


  I'm not going to explain partitions here. You know what they are, but does your cousin? Billy says, "You want me to make three new partitions, but there's no space to make them in!" My friend knows about partitions, and he knows that they are called C:, D: and E:. At least, there is lots of online information about partitions, and even step-by-step instructions about how to deal with them -- but they're not something Billy will understand in the first hour.


  I've been "lucky," I don't have driver issues with my computers. Well, "lucky" isn't quite accurate; I bought hardware which would work in Linux. Billy might recognize that he has a driver issue, and he knows what the next step is: find the CD which contains the drivers -- except when he's trying to install Linux, with one significant exception.


  The first driver issue which might come up is the video driver -- and often, it's because the video device is too new! There's a work-around, and it works every Tuesday when there is a full moon -- or that's what it feels like to Billy. You need to determine the perfect moment to press this key, and then you have to read what is on the screen, again, and we're not used to doing that. Then you type something which isn't a word, and press the magic key...


  Really? OK, technology could help with this one. A lot.


  Finally, there's the network driver. Many (most?) wireless network adapters "just work," (I've been "lucky.") Some will work after a bit of effort, some are really horrible, (you need the driver CD!) but they eventually work, and then there are a few which are hopeless. Even wired Ethernet adapters can be a problem, if they are brand new in the market. "It will work next year" isn't a wonderful solution to a person who has a problem today.


  And yes, technology could help with network adapters. However, the education part is to let Billy know that, instead of searching for the driver CD, he should be getting an exact identification of his hardware, then firing up Google.


  I would really like to get your thoughts on this: letters@fullcirclemagazine.org


  Audio Flux


  by Nicola Cappellini


  I know all you loyal readers were waiting in titillated anticipation for my ardour tutorial, but unfortunately because of poorly timed hardware failure (is there ever a good time?) it wont be this month. In the meantime here is some new ear candy for your listening enjoyment:


  Franklinin Karsilamasi, by Ansambl Mastika

  free download at: http://tinyurl.com/bopqa8p
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  Have you ever sat in an armchair and wondered what would happen if the Grateful Dead, slap bass, and the geopolitical region of Europe called the Balkans had a child? Me too! Well, this is the answer. Great instrumental interactions between the band members, how do they keep in time? Great find.


  Shes real, by The Luddites

  free download at: tinyurl.com/d6x83w3


  A spoken word song describing a person at a club, you know, THAT person. Funky bass and guitar riffs layered under noisy brass and a loud nostalgia for Frank Zappa, or am I thinking of Mingus? Whatever. A great group that mixes styles. Very refreshing and never a dull moment, as in: great bass clarinet solos (see The Bronx)!


  [image: ]


  Ningum segura os Beach Combers, by Os Beach Combers

  Free download at: tinyurl.com/chb9rf6


  The title track of the newest LP (no, seriously, they released it on vinyl) from the Rio de Janeiro surf band Os Beach Combers. Freaky, and flangey, perfect for listening by yourself to feed your secret and insatiable appetite for surf-rock. Remember to clear your browser history if you dont want anyone else to know...
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  Sunshine, by Little Dragon

  listen at: tinyurl.com/bn84hmc


  Great vocals by Yukimi Nagano over a deceptively transparent mix. Lots of interesting sounds going on here. Just sit back and prepare to get grooving. Band is so tight, everything is placed just where it needs to be and nothing more that shouldnt be there.
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  Soul Killing, by The Ting Tings

  listen at: tinyurl.com/c64gzfq


  Makes you want to shake your shoulders back and forth. Lots of instruments and sure to get your party moving. One of those choruses that you want to scream along to while pumping your index fingers into the air.
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  Ubuntu Women:Interview with Jasna Benčić


  by Elizabeth Krumbach
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  Elizabeth Krumbach: Can you tell us a little about yourself?

  Jasna Benčić: Hi to everyone. My name is Jasna and I come from Croatia. Currently I am a graduate student at Faculty of Organization and Informatics, (still working on my master’s thesis). Recently I had a chance to join: Croatian Linux Users' Association as a vice president, Muktware Linux and Free Software Magazine team as an editor/contributor, and Ubuntu Weekly Newsletter team as a summary writer/editor.


  EK: What inspired you to get involved in the Ubuntu community?

  JB: Well, I wouldn't call it an inspiration. What drove me to the Ubuntu community is a need for gaining new experience and meeting new people. I mean, I have been in the Ubuntu world since 8.04. It is still my favourite edition because I started with that distro – but not like an everyday user. I had a bachelor thesis "Characteristics of Ubuntu operating system". When I started I didn't have a clue what I got myself into. As time went by, I became more comfortable and I have loved Ubuntu since then. I must add that all these years I've been watching you guys on Youtube (UDS, etc..) and now I actually want to meet you and work with you.


  EK: What are your roles within the Ubuntu community, and what plans do you have for the future?

  JB: Currently I am working as a summary writer/editor at Ubuntu Weekly Newsletter. Plans :) There is a saying: "Don't talk about your plans because there is a possibility you won't accomplish them."

  I'd say that I have dreams considering Ubuntu and everything else. Will those dreams come true, it depends on a lot of factors, mostly me. My current dreams are: Work one day for Canonical, make education for pupils/students much more interesting and fun (at least in the area of Informatics since that is my profession).


  EK: Have you hit any barriers with getting involved, and what can you recommend to newcomers?

  No barriers really. You have been so approachable and helpful. I thank you a zillion times for that.

  I would recommend to newcomers: If you are in the Ubuntu world, and you want to gain more experience, do not hesitate to ask official members to join in. There are a lot of projects to get yourself involved in. You never know what kind of opportunities you might get.


  EK: Is there anything you feel the Ubuntu project could improve on when it comes to new folks coming to the project?

  JB: Nothing really. Maybe I am too subjective but, ever since I started with the Ubuntu Weekly Newsletter, I’ve had a chance to read blogs of official Ubuntu members. What I mean to say is, that every Ubuntu member is working on some project/part of Ubuntu, and every now and then they are asking for volunteers – while offering to help them to get involved. What more do you need?

  I even wondered where could I get official mentorship from Canonical... Then I told myself: "Ask official members of the Ubuntu project where you want to get yourself involved."


  EK: What other things are you interested in outside of open source and Ubuntu?

  JB: Related to my profession: Informatics in education, education psychology and methodology.

  Everything else is a mixture really: 3D (Blender), foreign languages, cooking, stand up comedy, education through whole life. To conclude this answer, there are a lot of things I'm interested in because I have a curious personality.


  Ubuntu Games News


  by Dougn Redhammer


  Just so you know, Gameolith (an online Linux game store) is moving to include Windows and Mac games in their catalog, as well as Linux.
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  On video is Gabe Newell about Steam on Linux (http://bcove.me/

  g5nyak0b). Valve have posted news on this recently as well as what game(s) that will be released with the client. Left For Dead 2 in this case. The client will be released sometime this year, and the first Linux test platform for the client will be Ubuntu. For more, see: http://blogs.valvesoftware.com/linux/.
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  Croteam the studio behind the Serious Sam FPS games has posted on their Facebook wall a screenshot with the caption "Serious Sam 3: BFE - running on Linux!". Serious Sam 3 is the latest game in the series that was released about 5 months ago on Windows using their new in house 3D game engine. No other information has been released but it looks like another developer is perhaps producing games for Linux that will be sold via Steam for Linux since Serious Sam 3 is essentially a steamworks game.


  Ubuntu Games


  by Jennifer Roger
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  McPixel is a point-and-click adventure game in which you have twenty seconds to prevent things from blowing up. Sounds easy enough, right? But wait - there’s pot smoking aliens, snakes on a plane, and many more ridiculously funny things keeping you from saving the world! Since its inception as a Ludum Dare 21 submission, McPixel has really blown up (pardon the pun) and with good reason. It now boasts 100 levels, free DLC updates, and a level creator for those who want to make even morecrazy levels. And it’s very, very addictive.
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  McPixel has a penchant for kicking people in the crotch and urinating on fires, but this quasi-hero has to use unorthodox methods to solve each puzzle. Thinking of dousing the bomb with water? Nope! Maybe just throwing it out the window will do? Wrong again, pal. What seems like the obvious solution is often a dead end, leaving you charred and moving on to the next round until you complete them all.


  There are six levels in each batch that you have to clear before unlocking the next batch. If you fail a level, you just move on to the next one until you’ve beaten them all. If you clear three levels in a row, you unlock a special bonus level. You have just one chance to figure out what to do before it abruptly ends, bringing you back to your trippy adventure.
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  Being a point and click, the mechanics are simple and the gameplay is straightforward. But the silly humor and task of finding all of the gags keeps you coming back for more. For those who want a real challenge, Endless Mode allows you to play every single level in a row. But the warning at the start of the game should not be ignored - after a long session, it can be really frustrating trying to figure out what to do next. So it’s a good idea to take a break before it’s yourmind that is about to explode.


  The soundtrack is good, but I did find it to be a bit repetitive after playing for a while. The retro style pixel graphics are crisp and smooth, and each level is quite imaginative. In general, the environments have enough to keep the gameplay fresh, and there’s always something that will have you giggling like a 13 year old boy.


  The first reaction to McPixel usually elicits a lot of WTF’s and general confusion, but don’t let the outrageous, juvenile style of humor fool you - it is a very well polished game that’s extremely enjoyable to play. You can try out the demo, or purchase the full DRM-free game plus the soundtrack for $9.99 from mcpixel.net.


  Pros:


  
    	clever and hilarious levels with nice retro style graphics


    	plenty of levels and extras for the quality and price

  


  Cons:


  
    	it can be truly maddening after playing for a long time


    	soundtrack can become redundant

  


  4/5

  


  
    BIO: Jennifer is a fine arts student from the Chicagoland area. You can follow @missjendie on Twitter or visit her blog at missjendie.com.
  


  FULL CIRCLE NEEDS YOU!


  A magazine isn't a magazine without articles - and Full Circle is no exception. We need your Opinions, Desktops, and Stories. We also need Reviews (games, apps, & hardware), How-To articles (on any K/X/L/Ubuntu subject), and any questions or suggestions you may have. We are always looking out for new articles to include in Full Circle. For article guidelines, ideas, and for issue translation, please see ourwiki: http://wiki.ubuntu.com/UbuntuMagazine


  Please email your articles to:

  articles@fullcirclemagazine.org

  If you would like to submit news, email it to:

  news@fullcirclemagazine.org

  Send your comments or Linux experiences to:

  letters@fullcirclemagazine.org

  Hardware/software reviews should be sent to:

  reviews@fullcirclemagazine.org

  Questions for Q&A should go to:

  questions@fullcirclemagazine.org

  Desktop screens should be emailed to:

  misc@fullcirclemagazine.org

  ... or you can visit our forum via: www.fullcirclemagazine.org


  Full Circle Team:


  Editor - Ronnie Tucker -

  ronnie@fullcirclemagazine.org

  Webmaster - Rob Kerfia -

  admin@fullcirclemagazine.org

  Comms Mgr - Robert Clipsham -

  mrmonday@fullcirclemagazine.org

  Podcast - Robin Catling -

  podcast@fullcirclemagazine.org


  Editing & Proofreading:


  
    	Mike Kennedy


    	Lucas Westermann


    	Gord Campbell


    	Robert Orsino


    	Josh Hertel


    	Bert Jerred

  


  Our thanks go out to Canonical, the many translation teams around the world, and to Thorsten Wilms for the current Full Circle logo.
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